
Oracle® Smart View for Office

Installation and Configuration Guide

Release 11.1.2.5.600

Updated: August 2016



Smart View Installation and Configuration Guide, 11.1.2.5.600

Copyright © 2004, 2016, Oracle and/or its affiliates. All rights reserved.

Authors: EPM Information Development Team

This software and related documentation are provided under a license agreement containing restrictions on use and
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit,
perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation
of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find
any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of
the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS:

Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or
documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure,
modification, and adaptation of the programs, including any operating system, integrated software, any programs installed
on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not
developed or intended for use in any inherently dangerous applications, including applications that may create a risk of
personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all
appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates
disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective
owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under
license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the
AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark
of The Open Group. Microsoft, Windows, PowerPoint, Word, Excel, Access, Office, Outlook, Visual Studio, Visual Basic,
Internet Explorer, Active Directory, and SQL Server are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

This software or hardware and documentation may provide access to or information about content, products, and services
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any
kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement
between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred
due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement
between you and Oracle.



Contents

Documentation Accessibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

Documentation Feedback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Chapter 1. Installing Smart View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Installation Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Installer Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Installation and Windows Access Control Settings . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Microsoft .NET Framework Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

BiDi Support in Installer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Planning Offline Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Installing from My Oracle Support or Oracle Technology Network . . . . . . . . . . . . . . . . .  11

Installing by Autodeployment in EPM System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Server Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Client Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Installing from EPM Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Workspace Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Client Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

Installing from Oracle BI EE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

Configuring the Oracle BI EE Analytics Home Page . . . . . . . . . . . . . . . . . . . . . . . . .  16

Installing from the Oracle BI EE Analytics Home Page . . . . . . . . . . . . . . . . . . . . . . .  18

Running Command Line or Silent Installations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Downloading Help for Local or Web Server Installation . . . . . . . . . . . . . . . . . . . . . . . . .  19

Uninstalling Smart View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Chapter 2. Administering Extension Installations and Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

About Extension Installations and Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Configuring Manual Extension Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Manual Update XML Defined . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Manual Update XML Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Configuring Auto-Update Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Auto-Update XML Defined . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Auto-Update XML Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

iii



Chapter 3. Accessing Shared Connections from an XML File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

About Accessing Shared Connections from an XML File . . . . . . . . . . . . . . . . . . . . . . . . .  31

Setting Up the Shared Connections XML File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Connection File Syntax and Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Connection File Syntax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Connection File Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Chapter 4. Installing and Configuring Help Locally or on a Web Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

About Installing Help Locally or on a Web Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Setting Up Help Locally or on a Web Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Optional Local Help Configuration via the Shared Connections XML File . . . . . . . . . . . .  42

Chapter 5. Tips and Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Diagnostics Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Installation and Languages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Windows, Office, and Smart View Locale Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Error When First Launching Excel After Installing Smart View . . . . . . . . . . . . . . . . . . . .  44

Internet Explorer Compatibility View Settings for Financial Reporting . . . . . . . . . . . . . . .  45

Working with Custom HTML-based Login Forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Browser Settings When Working with XML Files on HTTP Server . . . . . . . . . . . . . . . . . .  46

Flickering Issues on Office 2013 32-bit and 64-bit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Disable Window Transitions (DisableWindowTransitionsOnAddinTaskPanes) . . . . .  48

Disable Office Animations (DisableAnimations) . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Issues When Starting Excel in Automation Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Slowness with Extension Options Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Performance and Memory Usage Considerations for Smart View with Excel . . . . . . . . . . .  50

Smart View HTTP Session Timeout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

Duplicate Queries in Word Slow to Refresh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52

Issues with Dynamic Data Exchange Option in Excel . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Transition Navigation Keys Not Supported . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

Appendix A. Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

Essbase . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Planning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Financial Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Reporting and Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

FDM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Enterprise Performance Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

iv



Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support.
For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

5

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs


6



Documentation Feedback

Send feedback on this documentation to: epmdoc_ww@oracle.com

Follow EPM Information Development on these social media sites:

LinkedIn - http://www.linkedin.com/groups?gid=3127051&goback=.gmp_3127051

Twitter - http://twitter.com/hyperionepminfo

Facebook - http://www.facebook.com/pages/Hyperion-EPM-Info/102682103112642

Google+ - https://plus.google.com/106915048672979407731/#106915048672979407731/posts

YouTube - https://www.youtube.com/user/EvolvingBI

7

http://www.linkedin.com/groups?gid=3127051&goback=.gmp_3127051
http://twitter.com/hyperionepminfo
http://www.facebook.com/pages/Hyperion-EPM-Info/102682103112642
https://plus.google.com/106915048672979407731/#106915048672979407731/posts
https://www.youtube.com/user/EvolvingBI


8



1
Installing Smart View

In This Chapter

Installation Guidelines... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Installing from My Oracle Support or Oracle Technology Network ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

Installing by Autodeployment in EPM System.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12

Installing from EPM Workspace... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15

Installing from Oracle BI EE ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16

Running Command Line or Silent Installations... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18

Downloading Help for Local or Web Server Installation ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Uninstalling Smart View ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20

Oracle Smart View for Office uses a single installer for 64-bit and 32-bit versions of Microsoft
Office, starting with release 11.1.2.5.

Late-breaking information about the Smart View installation is provided in the Oracle Smart
View for Office Readme. You should thoroughly review this chapter along with the information
in the readme before installing Smart View.

Late-breaking information about the installation of Oracle Enterprise Performance
Management System products is provided in the Oracle Enterprise Performance Management
System Installation and Configuration Readme. Review this information thoroughly before
installing Oracle Enterprise Performance Management System products.

Installation Guidelines

Subtopics

l Installer Language

l Installation and Windows Access Control Settings

l Microsoft .NET Framework Support

l BiDi Support in Installer

l Planning Offline Support

The guidelines in this section should be considered when you install the Smart View client.
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Installer Language
The installer is automatically displayed in the language set in the Format field of the Windows
Region and Language dialog box in the Control Panel.

However, some messages, both on-screen and in the log file, cannot be translated and will appear
in English.

For more information about language settings, see “Windows, Office, and Smart View Locale
Settings” on page 44.

Installation and Windows Access Control Settings
Starting with the 11.1.2.5.400 release, you can install Smart View as a System user or as a non-
admin user.

Windows User Access Control (UAC) settings can affect Smart View installation. For
information on setting UAC, see the Microsoft Windows documentation.

Also, see the Oracle Smart View for Office Readme, “Known Issues,” “Installation” topic, for any
installation issues.

Table 1 Installation Guidelines for System, Admin, and Non-Admin Users

Installation
Context

Scenario UAC-Enabled Result

System user SmartView.exe is launched by the Windows scheduler or PsExec Not applicable Smart View is
installed on
the machine
level

Administrator The user runs SmartView.exe with the “Run as Administrator” command or
from an elevated command prompt

Depending on
the UAC level,
the user may
need to go
through the UAC
UI sequence

Smart View is
installed on
the machine
level

Non-admin user The user installing Smart View may or may not be a member of the
Administrators group.

Note: Not supported on Windows 8.x, Windows 10, or Windows server
platforms.

No UAC
interaction is
expected.

Smart View is
installed on
the current
user's level;
other users
will not be
able to run
Smart View

Notes:

l This scenario is not supported: A user installs Smart View, and then, on the same machine,
another user tries to install Smart View in the same location as the previous installation.

l After non-admin installations, launching Office applications with Smart View content from
Internet Explorer will fail in protected mode.
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l Upgrade in mixed installation context is not supported. For example, upgrading the
previously-installed per-machine installation with a per-user one is not supported (Error
1925).

l Silent installations are not supported for non-admin users. When attempting a silent
installation, the /s flag is ignored for non-admin users, causing the Smart View product
installer to launch.

l Non-admin users are not authorized to install Smart View in the C:\Program Files or
C:\Program Files (x86) folders.

Microsoft .NET Framework Support
To install and use Smart View 11.1.2.5.600, Microsoft .NET Framework 4.5 or higher is required.

BiDi Support in Installer
The Smart View installer does not fully support bidirectional (BiDi) languages. This can result
in installer screens containing formatting errors such as misaligned text and icons. The installer
can be used, however, and the installed Smart View product will display correctly in BiDi
languages.

Planning Offline Support
Although Planning Offline is supported for 64-bit operating systems, it is not supported for 64-
bit Smart View installations. If you use Planning Offline with Smart View, you must install the
32-bit version of Microsoft Office.

Note: Planning Offline is support with Oracle Hyperion Planning on-premises only. Planning
Offline is not supported with Oracle Planning and Budgeting Cloud.

Installing from My Oracle Support or Oracle Technology
Network

ä To install Smart View directly from My Oracle Support (MOS) or Oracle Technology
Network (OTN):

1 Before you begin, ensure that Microsoft .NET Framework 4.5 or higher is installed on the computer where
you are installing Smart View.

Microsoft .NET Framework 4.5 or higher is required to install and use Smart View.

2 Close all Microsoft Office applications.

3 Download the Smart View zip file from either MOS or OTN:

l From MOS:
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https://support.oracle.com/oip/faces/secure/km/DocumentDisplay.jspx?
id=1923582.1

This Knowledge Article provides a link to the current version of Smart View.

l From OTN:

http://www.oracle.com/technetwork/middleware/smart-view-for-office/overview/
index.html

Before downloading, review the “OTN License Agreement” accessed from the Smart
View download page to ensure that your usage is compliant.

4 Unzip the file to a temporary location.

5 Double-click SmartView.exe to start the installation wizard.

6 Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C:\Oracle\SmartView

If you are upgrading an existing installation of Smart View, the installer defaults to the folder
where Smart View was previously installed.

7 When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint,
or Word.

Installing by Autodeployment in EPM System
These instructions are for upgrading from Smart View 11.1.2.1.x and later only. If you are
upgrading from Smart View 11.1.2.0.x or earlier, use the autodeployment instructions provided
in the documentation for the specific release.

Server Setup

ä To set up the server environment for autodeployment of Smart View:

1 Enable autodeployment for your data provider as follows.

l Oracle Essbase: Choose a method:

m Use Administration Services Console (if available).

a. Connect to the Provider Server, select Edit, then Properties, then Client
Deployment.

b. Choose either Force Smart View client to upgrade or Warn Smart View client to
upgrade.

c. Select the Apply Smart View client to upgrade check box, and then click Apply.

m Update essbase.properties as follows:
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a. Navigate to EPM_ORACLE_INSTANCE\bin\essbase.properties.

b. Set either or both of these properties to true:

smartview.webservice.autodeploy.force=true
smartview.webservice.autodeploy.warn=true

l Planning:

a. Select Administration, then Manage Properties, and then System Properties.

b. Set these properties:

SMART_VIEW_FORCE_INSTALL=true
SMART_VIEW_DISPLAY_WARNING=true

l Oracle Hyperion Financial Management: In the Financial Management Web Server
Configuration Utility for Smart View, select Always force client to upgrade.

l Oracle Hyperion Reporting and Analysis: Autodeployment is automatic.

2 Make backup copies of your current SmartView.exe and version.xml before deploying the
replacement files.

3 Download the Smart View zip file from either OTN or MOS, as described in “Installing from My Oracle
Support or Oracle Technology Network” on page 11.

4 Unzip the downloaded file to a temporary location.

5 Copy SmartView.exe and version.xml to the location of the Oracle Hyperion Enterprise
Performance Management Workspace installation, typically:

C:\Oracle\Middleware\EPMSystem11R1\common\epmstatic\wspace\SmartView

This is the epmstatic location specific to Smart View.

6 Depending on which version of Smart View your users are upgrading from, perform either Option A OR
Option B.

l Option A (Upgrading from 11.1.2.1.x, 11.1.2.2.x, or 11.1.2.3.x)

If your users are upgrading from an installed Smart View version of 11.1.2.1.x,
11.1.2.2.x, or 11.1.2.3.x, open the version.xml file in the epmstatic location specific
to Smart View (see step 5), and edit the value in the installFile tag to point to the
location of the Smart View executable file (step 5) as follows:

<installFile>
     /epmstatic/wspace/SmartView/SmartView.exe
</installFile>

l Option B (Upgrading from 11.1.2.5.000 or Later)

If your users are upgrading from an installed Smart View version 11.1.2.5.000 or later,
choose only one of the following options and perform the tasks described:

m OTN Option

Do not modify the version.xml file in the epmstatic location specific to Smart
View (step 5).

13



Your users will automatically be directed to the Smart View page on OTN, where
they can download the installation zip file to their own machines, unzip the contents,
and run the installer.

m “epmstatic” Option

Open the version.xml file in the epmstatic location specific to Smart View (see
step 5) and edit the value in the installFile tag to point to the location of the
Smart View executable file (step 5) as follows:

<installFile>
     /epmstatic/wspace/SmartView/SmartView.exe
</installFile>

m Web App Server Option

Post the SmartView.exe file to a web app server in your environment, and then
modify the version.xml file to point to the fully-qualified URL.

a. Copy only the SmartView.exe to the web app server where you will be hosting
the file.

b. Open the version.xml file in the epmstatic location specific to Smart View
(see step 5), and edit the value in the installFile tag to point to the fully-
qualified URL where you are hosting the Smart View executable file (see step
a); for example:

<installFile>
     http://webServerHost:webServerPort/pathToSmartViewExe/SmartView.exe
</installFile>

Your Smart View users can now proceed with Client Installation.

Client Installation
In the previous section, Server Setup, if you chose the OTN Option in Option B, then your users
will be directed to OTN for the Smart View download. In that case, your users should follow the
instructions for OTN download and installation in “Installing from My Oracle Support or Oracle
Technology Network” on page 11.

If you did not choose the epmstatic Option or Web App Server Option in Option B, then
complete the following procedure.

ä To install the Smart View client:

1 In Smart View, select Panel.

2 Connect to a data source in one of the following ways:

l Through a shared connection

l Through a private connection with the following URL:

m Essbase: http://<server>:19000/aps/SmartView

m Planning: http://<server>:19000/HyperionPlanning/SmartView

14



m Financial Management: http://<server>:19000/hfmofficeprovider/
hfmofficeprovider.aspx

m Reporting and Analysis: http://<server>:19000/raframework/browse/
listxml

Note: If you are using Reporting and Analysis release 11.1.2.1.000 or earlier, Smart
View autodeployment will not work (10233672, 12870087).

3 When the message “New Smart View client version available” is displayed, select Click here to
Install.

4 In the Internet Explorer browser that launches, in File Download, select Run.

Note: Internet Explorer will launch even if Firefox is your default browser.

5 If a Microsoft Excel security warning is displayed, select Run.

6 When prompted, confirm the upgrade; click Yes.

7 The installation wizard is displayed; click OK.

The installer is automatically displayed in the language set in the Format field of the Windows
Region and Language dialog box in the Control Panel.

8 If prompted, close all open Microsoft Office applications, and then click OK.

9 In the installation wizard, click OK and follow the prompts to install Smart View.

10 When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint,
or Word.

11 Open Excel.

12 On the Smart View ribbon, select the arrow next to Help, and then select About.

13 Verify the new version of Smart View.

Installing from EPM Workspace

Subtopics

l Workspace Setup

l Client Installation

Workspace Setup

ä To set up the Workspace environment for the updated Smart View installer:

1 Make backup copies of your current SmartView.exe and version.xml before deploying the
replacement files.
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2 Download the Smart View zip file from either OTN or MOS, as described in “Installing from My Oracle
Support or Oracle Technology Network” on page 11.

3 Unzip the downloaded file to a temporary location.

4 Copy SmartView.exe and version.xml to the location of the EPM Workspace installation,
typically:

C:\Oracle\Middleware\EPMSystem11R1\common\epmstatic\wspace\SmartView

Client Installation

ä To install Smart View from EPM Workspace:

1 In EPM Workspace, select Tools, then Install, and then Smart View.

2 In File Download, select Run.

3 If a Microsoft Excel security warning is displayed, select Run.

4 Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C:\Oracle\SmartView

If you are upgrading an existing installation of Smart View, the installer defaults to the folder
where Smart View was previously installed.

5 When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint,
or Word.

Installing from Oracle BI EE

Subtopics

l Configuring the Oracle BI EE Analytics Home Page

l Installing from the Oracle BI EE Analytics Home Page

Configuring the Oracle BI EE Analytics Home Page

Note: Configuring a custom download link for the Smart View installer applies to Oracle
Business Intelligence Enterprise Edition 11.1.1.7.1 and later versions, and might not be
available in earlier versions.

Starting in Oracle BI EE release 11.1.1.9, the Smart View for MS Office link on the Download BI
Desktop Tools drop-down list points to the Smart View download on Oracle Technology
Network.
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If you do not want to direct your users to Oracle Technology Network, you can configure the
Smart View for MS Office link to point to a custom download link for the Smart View installer.
You can then ensure that the correct version of Smart View for your environment is always
available to your users. Do this by adding the SmartViewInstallerURL element to
instanceconfig.xml.

You can configure the download link point to a location where the smartview.exe resides; for
example:

l An external URL

l An internal URL, such as internal web page or intranet location where the installation can
start immediately

l A folder on a local server where the installation can start immediately

ä To configure a custom download link for the Smart View installer:

1 Open the instanceconfig.xml file for editing

Refer to “Where Are Configuration Files Located?” in the Oracle Fusion Middleware System
Administrator's Guide for Oracle Business Intelligence Enterprise Edition.

2 Locate the CatalogPath and <DSN>AnalyticsWeb</DSN> sections and add the
SmartViewInstallerURL element after those sections.

3 Use the syntax in the following examples to add the SmartViewInstallerURL element.

Example for download from Oracle Technology Network:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</
CatalogPath>
<DSN>AnalyticsWeb</DSN>
<SmartViewInstallerURL>http://www.oracle.com/technetwork/middleware/epm/downloads/
smart-view-1112x-1939038.html</SmartViewInstallerURL>

Example for download from an intranet site:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</
CatalogPath>
<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>http://myserver:8080/downloads/
smartview.exe</SmartViewInstallerURL>

Example for download from an internal server:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</
CatalogPath>
<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>\\myserver\downloads\smartview.exe</
SmartViewInstallerURL> 

4 Save your changes and close the file.

5 Restart the Oracle BI EE instance.
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Installing from the Oracle BI EE Analytics Home Page

ä To install Smart View from Oracle BI EE Home:

1 In Oracle BI EE Analytics Home page, click the arrow next to Download BI Desktop Tools, and then
select Smart View for MS Office.

If you are directed to the Smart View download page on Oracle Technology Network, then
follow the procedure in “Installing from My Oracle Support or Oracle Technology Network”
on page 11. Otherwise, proceed with step 2.

2 Choose an option:

l Click Run to run the installer directly.

If the User Account Control dialog box is displayed, click Yes, and then continue to
step 3.

l Click Save to save the Smart View installer file to a directory to which you have access
and from which you can run executable files.

Open the folder where you saved the Smart View executable and double-click it to run
it. Then continue to step 3.

3 Select the language to use for the installation wizard.

4 Click Next.

5 Follow the prompts in the wizard.

6 When installation is complete, click Finish.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint,
or Word.

Running Command Line or Silent Installations
In addition to command line installations, administrators can enable silent installations—
installations that do not require settings to be specified each time—for Smart View. The silent
installation command can be included in scripts to automate installation.

Note: Silent installations are not supported for non-admin users.

The silent installer wrapper follows these rules:

l It passes the value of the /v parameter intact to the MSI.

l The /s flag is converted to /qn and passed to the MSI. There is no need to specify the /qn
parameter if /s is already present in your script.

l Unless the /v parameter contains any /q specifier, the wrapper passes /qb+ to the MSI.
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Table 2 Command Line Options for Client Installations

Option Usage

/v"command line options" Specifies command line options to be passed to the client installer.

/s Runs the client installer as a silent installer.

INSTALLDIR= Specifies the installation directory.

l*v log file path and name Logs installation information in the specified file.

/extensionupdatelist= Path to UpdateList.xml

Before you begin, follow the procedure in “Installing from My Oracle Support or Oracle
Technology Network” on page 11 to download the Smart View installation zip file and unzip it
to the folder you will be working in.

ä To run silent installations:

1 Open a command prompt.

2 Navigate to the directory of the Smart View installer.

3 Run the installation commands; for example:

l To install in the default directory, run:

SmartView.exe /s

l To install in another directory, run:

SmartView.exe /s /v" INSTALLDIR=<target path>"

For example:

SmartView.exe /s /v" INSTALLDIR=D:\SmartView"

l To specify the location of UpdateList.xml, run:

SmartView.exe /s /extensionupdatelist=<path to UpdateList.xml>

l To run a silent installation and log the installation sequence:

SmartView.exe/s/v” INSTALLDIR=D:\SmartView /L*v c:\install.log”

Downloading Help for Local or Web Server Installation
After installing Smart View, the online help is retrieved from a URL hosted on the Oracle.com
web site. This is the default behavior for Smart View, and no changes are required by users to
launch help.

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than Oracle.com
are:

l Help files must be installed on a local drive on an individual's computer for Section 508
accessibility purposes.
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l Internet access limitations; for example, your users only have access to URLs on your
organization's intranet.

To accommodate the above types of cases, a downloadable help zip file is posted on My Oracle
Support as a patch to the current Smart View release.

The procedure below describes downloading the help zip file. Further instructions for
installation and configuration are in the following guides:

l Chapter 4, “Installing and Configuring Help Locally or on a Web Server” in this guide.

l Oracle Smart View for Office Accessibility Guide. See “Installing and Configuring Help
Locally.”

ä To download the Smart View help zip file from My Oracle Support (MOS):

1 Log in to MOS.

2 Select the Patches & Updates tab.

The Patch Search area is displayed at the right of the screen with the Search tab selected by
default.

3 Under the Number/Name or Bug Number (Simple) heading, ensure that Patch Name or Number is
selected in the drop-down list box.

4 In the Patch Search text box, type this Smart View patch number:

23206405

The Patch Search text box is to the right of the Patch Name or Number drop-down list box.

5 Click Search.

6 Download the patch zip file to a temporary directory.

7 To install and configure the help according to your requirements, follow the instructions in either of the
following guides:

l Chapter 4, “Installing and Configuring Help Locally or on a Web Server” in this guide.

l Oracle Smart View for Office Accessibility Guide. See “Installing and Configuring Help
Locally.”

Uninstalling Smart View
This topic describes uninstalling Smart View.

To uninstall extensions, see “Uninstalling Extensions” in the Oracle Smart View for Office User's
Guide.

ä To uninstall Smart View:

1 Before you begin, close all Office applications.

2 Go to your Windows system Control Panel and navigate to Uninstall or change a program.
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3 Locate and select the version of Smart View that applies to your installation:

l Oracle Smart View 32-bit for Office

l Oracle Smart View 64-bit for Office

4 Click Uninstall.
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The extension installation and update process described in this topic enables Smart View end
users to install, update, or uninstall extensions based on parameters set by the Smart View
administrator in the manifest file, UpdateList.xml.

About Extension Installations and Updates

Auto-Update versus Manual Update

In releases earlier than Smart View 11.1.2.5.400, extensions were updated using the Auto-
Update process. To update extensions with Auto-Update, Smart View end users could go to the
Extensions tab of the Options dialog box and click the Check for updates link or select the Check
for updates when Microsoft Office starts check box to initiate extension updates. For all
extensions, if any updates were available, they were retrieved and installations were automatically
initiated.

In release 11.1.2.5.400 and later, you can customize the extension update process so that Smart
View end users can control when they install, update, and remove extensions. The Smart View
administrator configures attributes in the UpdateList.xml manifest file to control the options
available to the users. If the administrator does not configure these attributes in
UpdateList.xml, extensions will continue to be updated using the existing Auto-Update
process.

Types of Extensions

There are two types of extensions that can be installed on a Smart View client machine:

l Provider extensions. Extensions that are dependent on, or integrated with, Oracle
components are provider extensions. Examples are the Oracle Hyperion Disclosure
Management and Oracle Hyperion Financial Reporting extensions. Provider extensions can
be configured as required extensions.
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l Per-user extensions. Extensions that are installed in the user’s application data folder. These
extensions may or may not be dependent on Oracle components. Additionally, per-user
extensions can also be configured as required extensions.

The Smart View administrator configures the UpdateList.xml file to specify the list of provider
and per-user extensions available to end users along with options for installing, updating, and
removing them. Additionally, per-user extensions can also be configured to display an indicator
for required extensions and does not force the installation. The Smart View end user then accesses
the Options dialog box and installs, updates, or uninstalls the extensions that are available to him
or her in the Extensions tab.

To configure provider and per-user extension installation, uninstallation, and updating,
complete the procedure in “Configuring Manual Extension Updates” on page 24.

If you do not want to make changes to the extension update process, you may refer to
“Configuring Auto-Update Extensions” on page 29 for information on the structure of the
XML and examples, but you do not need to take any further action.

For instructions on installing, updating, and removing extensions in Smart View, end users can
refer to the procedure topics in “Extensions” in the “Smart View Options” chapter in the Oracle
Smart View for Office User's Guide.

About the Oracle Journals for Financial Management Extension

The Oracle Journals extension is unique among Smart View extensions in that the extension
installer file is included in the extensions folder of the Smart View installation. End users can
install the Oracle Journals extension directly from the extensions folder of their Smart View
installation.

Or, as administrator, you can control how your Smart View end users install the Oracle Journals
extension, automatically or manually, via the Extensions page of the Smart View Options dialog
box.

If you choose to set up automatic or manual installations of the Oracle Journals extension, you
should install Smart View in a test environment first, then refer to the UpdateList.xml file,
found in the extensions folder of your Smart View installation. Use the entry in this file as a
guideline for the Oracle Journals entry you will add to the UpdateList.xml file, as described
in “Configuring Manual Extension Updates” on page 24.

Configuring Manual Extension Updates

Subtopics

l Manual Update XML Defined

l Manual Update XML Example

Auto-Update extensions in the UpdateList.xml manifest file can be configured so that the
Smart View end user can see the available extensions, including per-user extensions, and install
them from the Extensions tab of the Options dialog box.
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You can add two attributes, visible and allowUninstall, to the UpdateList.xml manifest
file to change the behavior of the extensions from auto-update to manual update so that the
extensions are displayed in the Options dialog box:

l visible—A value of “1” indicates that the extension will appear in the Extensions tab of
the Smart View  Options dialog and will NOT be part of the Auto-Update process.

If the visible attribute is missing or the value is not “1”, the extension is included in the
Auto-Update process.

l allowUninstall—A value of “1” indicates that the user can initiate an uninstall through
the Extensions tab of the Options dialog box using the Remove link.

If the allowUninstall attribute is missing or the value is not “1”, the user may not initiate
an uninstall in the Extensions interface (the Remove link will not be there).

This procedure is optional. If you choose not to add the attributes to UpdateList.xml,
extensions will continue to be updated as they were in releases earlier than 11.1.2.5.400. In
pre-11.1.2.5.400 releases, users click the Check for updates link or select the Check for updates
when Microsoft Office starts check box to initiate extension updates.

See “Manual Update XML Defined” on page 26 and “Manual Update XML Example” on page
28 for reference.

ä To add attributes to the UpdateList.xml manifest file for extensions:

1 Open the UpdateList.xml file for editing.

The manifest file is found in two locations:

l epmstatic:

http://server:port/epmstatic/smartview/Client/UpdateList.xml

l The location pointed to by the <extensionupdatelist> tag in C:\Oracle
\SmartView\cfg\properties.xml.

To populate the <extensionupdatelist> tag, you can either perform a command
line installation, as described in “Running Command Line or Silent Installations” on
page 18, or manually update the tag in the properties.xml file.

Note: In properties.xml, if multiple URLs exist for an extension installer, Smart
View checks all locations and installs from the location containing the latest
version.

If multiple URLs exist for the same version of an extension installer, Smart View
installs from the first URL in the list.

2 Optional: To display an extension in the Extensions tab of the Options dialog box, and exclude the
extension from the Auto-Update process, add the visible="1" attribute to the XML for the extension;
for example:

<update>
   version="11.1.2.3.500.021"
   extension id="Some.Unique.Id.That.Matches.Extension.Descriptor.Id"
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
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   visible="1"
   allowUninstall="1">Oracle Disclosure Management
</extension>

Figure 1 shows an example of an extension displayed in the Extensions tab.

Figure 1 Extension as Displayed in the Extensions Tab

3 Optional: To display the Remove button, , for an extension, add the
allowUninstall="1" attribute to the XML for the extension; for example:

<update>
   version="11.1.2.3.500.021"
   extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
   visible="1"
   allowUninstall="1">Oracle Disclosure Management
</extension>

Figure 2 shows an example of an extension displayed in the Extensions tab.

Figure 2 Extension as Displayed in the Extensions Tab

4 For each provider and per-user extension, repeat step 2 and step 3 according to your requirements.

5 Optional: To remove a single extension from the list of extensions available for Auto-Update in the
UpdateList.xml file, use the alternative method of commenting out the extension with the <!--
and --> characters; for example:

<!--
<extension>
location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi" version="11.1.2.4.078" 
id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn"> Oracle Disclosure Management
</extension>
-->

You can also comment out the entire list of extensions if your goal is to exclude all extensions
from the manual update process.

Manual Update XML Defined
l <update>
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The root node. This is a tag.

l <extension>

Parent node for <extension> attributes. This is a tag.

Attributes of <extension> are:

m id

The extension identifier. The identifier must match the SVExtensionDescriptor.GUID
defined in the extension. It does not need to be a GUID, it only needs to be unique. This
name will appear in the Windows Registry. For this reason, Oracle recommends using
readable identifiers; for example, Oracle.Disclosure.Management.

m format

A value of “1” indicates that the entry for the extension uses the manual update XML
format introduced in Smart View 11.1.2.5.400. This XML format supports more user
interface features than the standard Auto-Update format.

m version

The version number of the extension. The version number must match exactly with the
extension descriptor version in the extension assembly.

m svVersion

The Smart View version that the extension works with.

m visible

Set this value to “1” to display the extension in the Extensions tab of the Options dialog
box. When this is set to “1”, the extension will NOT be part of the Auto-Update process.

m manualUpdate

Set this value to “1” if the user needs to close Excel for installation update. The update
installer file will be downloaded and a message will be displayed indicating the required
restart of Office. Also, the download folder will be opened.

m manualInstall

Set this value to “1” if the user needs to close Excel for installation. The installer file will
be downloaded and a message will be displayed indicating the required restart of Office.
The download folder will be opened.

m allowUninstall

Set this value to “1” to display the Remove button in the Extensions tab of the Options
dialog box.

m type

The type of extension. Valid values are:

o 0 = optional extension

o 1 = provider extension

o 2 = Smart View client
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m required

Set to display a “Required” or “Recommended” icon for the extension. No action is
done other than the visible icon.

l <name>

The name of the extension. This is a tag.

l <desc>

The extension description. This is a tag.

Uses the “default” attribute. The default description for the extension will be the description
displayed in the Extensions tab.

l owner

The creator or owner of the extension; for example, Oracle.

l location

The location and file name of the extension installer file. This can be msi or svext; exe is
not supported.

l <uninstallMsg>

Optional. For uninstalls, displays a custom message to the user.

Uses the “default” attribute. The default description for the uninstallMsg will be the custom
message displayed during uninstall.

l <options>

Optional. For msi installations only. All options for the Microsoft Windows Installer Tool,
Msiexec.exe, are supported.

Manual Update XML Example
<update>
<extension id="Oracle.SmartView.ExtensionSamples.PowerPack.AdjustData"
  format="1"
  version="1.1.3.0" 
  svVersion="11.1.2.2.310" 
  visible="1"  allowUninstall="1" 
  manualUpdate=”0”
  manualInstall=”0”
  type="0" 
  required="1">
  <name>Adjust Data</name>
  <desc default="Simple data adjustment panel for use with Smart View">
  <owner>Oracle</owner>
  <location>file://server_name/shared/ExtensionInstallers/AdjustDataInstaller.svext
  </location>
  <uninstallMsg default=”This will remove the extension and all its components"
  </uninstallMsg>
</extension>
</update>
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Configuring Auto-Update Extensions

Subtopics

l Auto-Update XML Defined

l Auto-Update XML Example

You can add the visible and allowUninstall attributes to the UpdateList.xml manifest
file to change the behavior of the extensions that are part of the Auto-Update process.

If you do not add the attributes to UpdateList.xml, extensions will continue to be updated
using the existing Auto-Update process.

To add the visible and allowUninstall attributes to the Auto-Update extensions, complete
the procedure in “Configuring Manual Extension Updates” on page 24.

See “Auto-Update XML Defined” on page 29 and “Auto-Update XML Example” on page
30 for reference.

You can also remove an single extension from the list of extensions available for Auto-Update
in the UpdateList.xml file by commenting out the extension using the <!-- and -->
characters. For example:

<!--
<extension>
location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi" version="11.1.2.4.078" 
id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn"> Oracle Disclosure Management
</extension>
-->

If you comment out the entire list of extensions, then all extensions are excluded from the manual
update process.

Auto-Update XML Defined
l <update>

The root node. This is a tag.

l <extension>

Text that contains the extension name. This is a tag. The extension name appears in the
Extensions tab of the Options dialog box. Examples of extension names are Oracle Predictive
Planning Extension, Disclosure Management, or Adjust Data.

Attributes of <extension> are:

m id

The extension identifier. The identifier must match the SVExtensionDescriptor.GUID
defined in the extension. It does not need to be a GUID, it only needs to be unique. This
name will appear in the Windows Registry. For this reason, Oracle recommends using
readable identifiers; for example, Oracle.Disclosure.Management.

m version
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The version number of the extension.

m location

The location and file name of the extension installer file. This can be msi or svext;
exe is not supported.

m operation

Optional. For Auto-Updates, set this value to “delete” to have the uninstall automatically
begin when the user opens Office.

Note: The first time a user opens Office, if Smart View determines that the extension
needs to be uninstalled, the subsequent opening of Office initiates the uninstall
process.

m options

Optional. For msi installations only. All options for the Microsoft Windows Installer
Tool, Msiexec.exe, are supported.

m visible

Set this value to “1” to display the extension in the Extensions tab of the Options dialog
box. When this is set to “1”, the extension will NOT be part of the Auto-Update process.

m allowUninstall

Set this value to “1” to display the Remove button in the Extensions tab of the Options
dialog box.

Auto-Update XML Example

<update>
<extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
   version="11.1.2.3.500.021"
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
   visible="1"
   allowUninstall="1">Disclosure Management
</extension>

<extension id="Another.Unique.Id"
   version="11.1.2.3.300"
   location="/epmstatic/SomeSetup.msi"
   operation=”delete”>Crystal Ball EPM
</extension>

<extension id="And.Another.Unique.Id"
   version="11.1.2.3.300"
   location="/epmstatic/SomeSetup.msi"
   options="/promptrestart">Oracle Predictive Planning"
</extension>
</update>
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About Accessing Shared Connections from an XML File

Note: The procedures in this chapter apply to shared connections only.

You can use shared connection information from an XML file to connect to supported Smart
View providers, both cloud and on-premises. The XML file can exist either locally on each
individual Smart View client machine or on a web server. Smart View end users point to this
XML file in the Shared Connections URL field of the Options dialog box, and then access the
available providers as they would any other shared connection to which they have access.

To connect to an Oracle BI EE provider from the Shared Connections Panel in Smart View, you
must follow the procedures in this topic. However, you may also connect to Oracle BI EE data
sources from the Private Connections Panel using the procedure described in “Creating Private
Connections” in the Oracle Smart View for Office User's Guide.

Note: Only ASCII characters are supported in the XML file. Do not use non-ASCII characters
in any of the entries you make in this file.

Caution! The procedures in this chapter should be completed by the Smart View
administrator.

Setting Up the Shared Connections XML File
Setting up the shared connections XML file involves preparing the XML file distributing it to
your users.
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ä To set up shared connections in an XML file:

1 Create an empty XML file using any text editor and save it on your Smart View client machine.

Give the file a meaningful name, such as SmartViewProviders.xml, and ensure that it
has the .xml extension.

Note: Only ASCII characters are supported in the XML file. Do not use non-ASCII
characters in any of the entries you make in this file.

2 Add the following line to the beginning of the file:

<?xml version="1.0" encoding="UTF-8"?>

3 Next, add the opening res_GetProvisionedDataSources tag:

<res_GetProvisionedDataSources>

4 Add entries for the applicable providers.

You can add entries for Oracle Hyperion Provider Services (Essbase), Planning (both on-
premises and in Oracle Planning and Budgeting Cloud), Financial Management, Reporting
and Analysis, Oracle Hyperion Strategic Finance, Oracle BI EE, and Oracle Enterprise
Performance Reporting Cloud. The XML can contain entries for supported cloud providers,
on-premises providers, or a mix of both.

When you create your entries, copy the syntax exactly and make ONLY these substitutions:

l In the Product tag, displayVersion attribute:

version—The version number of the specified provider.

l In the Server tag, context attribute:

webServerHost—The web server host machine name.

webServerPort—The web server port number. Use the default port number that is
already noted in the syntax for each provider. Or, if you have configured your system
using non-default port numbers, provide them.

The syntax for each provider type is below.

Oracle Hyperion Provider Services (Essbase)

<Product id="APS" name="APS-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Provider Services" context="http://
webServerHost:webServerPort/aps/SmartView"></Server>
</Product>

Planning or Oracle Planning and Budgeting Cloud

<Product id="HP" name="HP-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Planning, Fusion Edition" context="http://
webServerHost:webServerPort/HyperionPlanning/SmartView"></Server>
</Product>

Financial Management

<Product id="HFM" name="HFM-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Financial Management, Fusion Edition" context="http://
webServerHost:webServerPort/hfmadf/../hfmofficeprovider/HFMOfficeProvider.aspx"></
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Server>
</Product>

Reporting and Analysis

<Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="version">
<Server name="Reporting and Analysis Framework" context="http://
webServerHost:webServerPort/raframework/browse/listXML"></Server>
</Product>

Oracle Hyperion Strategic Finance

<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" 
displayVersion="version">
<Server name="Oracle Hyperion Strategic Planning, Fusion Edition" 
context="webServerHost:webServerPort/StrategicPlanning/SmartView"></Server>
</Product>

Oracle Business Intelligence Enterprise Edition

<Product providerType="ExtensionProvider" id="27EE9B0D-D5F5-42c9-AFC5-44FEA770C693" 
name="OBI EE-11.1.1.7" displayVersion="version">
<Server name="Oracle BI, Fusion Edition" context="OBI:http://
webServerHost:webServerPort/analytics/jbips"></Server>
</Product>

Enterprise Performance Reporting Cloud Service

<Product id="EPRCS" name="Enterprise Performance Reporting Cloud Service" 
displayVersion="version"> 
<Server name="EPRCS" context="http://webServerHost:webServerPort/epm/SmartView"> </
Server>
</Product>

5 Optional: If you are planning to access help locally or from an internal URL, add an entry for locating
the help:

l Help installed on a local drive:

<helpurlcontext>file:///parent_language_folder_path/</helpurlcontext>

For example:

<helpurlcontext>file:///C:/Oracle/SmartView/smartview_help/</helpurlcontext>

l Help installed on a web server:

<helpurlcontext>http://webServerHost:webServerPort/pathToHelpFiles/
smartview_help/</helpurlcontext>

For example:

<helpurlcontext>http://abcxyzco.com:12345/user_documentation/smartview_help/</
helpurlcontext>

Notes:

l Perform this step ONLY if you are planning to access shared connections from an XML
file AND are required to access help either from a local drive or a web server within your
organization. See “Installing and Configuring Help Locally or on a Web Server” on page
39 for instructions on setting up help.
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l If you use the <helpurlcontext> tag, the help location you specify overrides the
default or modified location specified in the <helpurlcontext> tag in the
properties.xml file, as described in “Optional Local Help Configuration via the
Shared Connections XML File” on page 42.

6 Optional: Add an entry for the User Productivity Kit (UPK):

<UPK>http://link to User Productivity Kit</UPK>

For example:

<UPK>http://download.abcxyzco.com/ocomdocs/PlayerPackage/data/toc.html</UPK>

7 Add the closing res_GetProvisionedDataSources tag to complete the file, then save it.

</res_GetProvisionedDataSources>

See “Connection File Syntax and Example” on page 36 for the full syntax and an example
of how this file should be set up.

8 Test the file:

a. Perform an action:

l If you plan to have users copy the XML file to their local drive, ensure that the file
is copied to a local drive on your Smart View client machine.

For example, the file may be copied to the SmartView\bin directory.

l Alternatively, if you plan to copy the file to a web server, ensure that the file is
accessible to your users from a fully-qualified URL that includes the XML file name
and the .xml extension.

b. Start Smart View and in the Options dialog box, edit the Shared Connections URL to add
the full path to the file or a URL, ensuring that the .xml file name extension is included.

Note: This feature will not work if the .xml file name extension in not included at the
end of the local drive path or URL.

l Local drive example:

C:/Oracle/SmartView/bin/SmartViewProviders.xml

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file should now be available in the list of shared
connections.

l Web server URL syntax:

http://webServerHost:webServerPort/pathToFile/filename.xml

Web server URL example:

http://abcxyzcowebserver:1234/SmartViewDataSources/SmartViewProviders.xml

The URL should now be available in the list of shared connections.
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c. Connect to the file using the Shared Connections option in the Smart View Panel, as
described in “Connecting to Data Sources” in the Oracle Smart View for Office User's
Guide.

If you do not see provider entries listed in the Shared Connections drop-down list, then
the XML file may contain incorrect syntax or invalid characters.

Tip: Verify the XML by opening the file in a browser; for example, in Internet Explorer.
The browser will specify the invalid syntax. Correct any errors in the XML file
editor, save, and refresh the browser display.

9 When the XML file is correct and complete, perform one of the following procedures:

l If you plan to have users copy the XML file to their local drive, distribute the file to your
Smart View users with these instructions:

a. Do not modify this file in any way.

b. Copy the file to a local drive on your Smart View client machine.

For example, the file may be copied to the SmartView\bin folder.

c. Start Smart View and in the Options dialog box, edit the Shared Connections URL
with the full path to the file on the local drive, including the file name and .xml
extension; for example:

C:/Oracle/SmartView/bin/SmartViewProviders.xml

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file is now available in the list of shared connections.

d. Test by connecting to the file using the Shared Connections option in the Smart
View Panel, as described in “Connecting to Data Sources” in the Oracle Smart View
for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

l If you plan to copy the XML file to a web server, notify your Smart View users with these
instructions:

a. Start Smart View and in the Options dialog box, edit the Shared Connections URL
with the URL provided, including the file name and .xml extension; for example:

http://abcxyzcowebserver:1234/SmartViewDataSources/SmartViewProviders.xml

b. Test by connecting to this URL using the Shared Connections option in the Smart
View Panel, as described in “Connecting to Data Sources” in the Oracle Smart View
for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

c. Internet Explorer users: To use the URL given in step a, Oracle recommends setting
the following options in Internet Explorer:

i. Select Tools, then Internet Options.

ii. In the General tab, Browsing history group, select Settings.
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iii. In the Check for newer versions of stored pages section, select Every time I visit
the webpage, and then click OK.

iv. In the Internet Options dialog box, select the Advanced tab.

v. In the Security section, select the Empty Temporary Internet Files folder when
browser is closed option.

vi. Click OK to close Internet Options and restart the browser.

Connection File Syntax and Example

Subtopics

l Connection File Syntax

l Connection File Example

Connection File Syntax
Below is the file syntax in its entirety:

<?xml version="1.0" encoding="UTF-8"?>
<res_GetProvisionedDataSources>
<Product id="APS" name="APS-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Provider Services" context="http://
webServerHost:webServerPort/aps/SmartView"></Server>
</Product>
<Product id="HP" name="HP-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Planning, Fusion Edition" context="http://
webServerHost:webServerPort/HyperionPlanning/SmartView"></Server>
</Product>
<Product id="HFM" name="HFM-11.1.2" displayVersion="version">
<Server name="Oracle Hyperion Financial Management, Fusion Edition" context="http://
webServerHost:webServerPort/hfmadf/../hfmofficeprovider/HFMOfficeProvider.aspx"></
Server>
</Product>
<Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="version">
<Server name="Reporting and Analysis Framework" context="http://
webServerHost:webServerPort/raframework/browse/listXML"></Server>
</Product>
<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" 
displayVersion="version">
<Server name="Oracle Hyperion Strategic Planning, Fusion Edition" context="http://
webServerHost:webServerPort/StrategicPlanning/SmartView"></Server>
</Product>
<Product providerType="ExtensionProvider" id="27EE9B0D-D5F5-42c9-AFC5-44FEA770C693" 
name="OBI EE-11.1.1.7" displayVersion="version">
<Server name="Oracle BI, Fusion Edition" context="OBI:http://webServerHost:webServerPort/
analytics/jbips"></Server>
</Product>
<Product id="EPRCS" name="Enterprise Performance Reporting Cloud Service" 
displayVersion="version"> 
<Server name="EPRCS" context="http://webServerHost:webServerPort/epm/SmartView"></
Server>
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</Product>
<helpurlcontext>a valid entry as per optional step 5</helpurlcontext>
<UPK>http://link to User Productivity Kit</UPK>
</res_GetProvisionedDataSources>

Connection File Example
The following example includes an entry for each provider type and also includes an entry for
accessing help from an organization's internal web server:

<?xml version="1.0" encoding="UTF-8"?>
<res_GetProvisionedDataSources>
<Product id="APS" name="APS-11.1.2" displayVersion="11.1.2.2.500">
<Server name="Oracle Hyperion Provider Services" context="http://abcsvr.xyzco.com:19000/
aps/SmartView"></Server>
</Product>
<Product id="HP" name="HP-11.1.2" displayVersion="11.1.2.2.000">
<Server name="Oracle Hyperion Planning, Fusion Edition" context="http://abcsvr.xyzco.com:
19000/HyperionPlanning/SmartView"></Server>
</Product>
<Product id="HFM" name="HFM-11.1.2" displayVersion="11.1.2.2.300">
<Server name="Oracle Hyperion Financial Management, Fusion Edition" context="http://
abcsvr.xyzco.com:19000/hfmadf/../hfmofficeprovider/HFMOfficeProvider.aspx"></Server>
</Product>
<Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="11.1.2.2.000">
<Server name="Reporting and Analysis Framework" context="http://abcsvr.xyzco.com:19000/
raframework/browse/listXML"></Server>
</Product>
<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" 
displayVersion="11.1.2.2.00.2266">
<Server name="Oracle Hyperion Strategic Planning, Fusion Edition" context="http://
abcsvr.xyzco.com.com:8900/StrategicPlanning/SmartView"></Server>
</Product>
<Product providerType="ExtensionProvider" id="27EE9B0D-D5F5-42c9-AFC5-44FEA770C693" 
name="OBI EE-11.1.1.7" displayVersion="11.1.1.7">
<Server name="Oracle BI, Fusion Edition" context="OBI:http://abcsvr.xyzco.com:9704/
analytics/jbips"></Server>
</Product>
<Product id="EPRCS" name="Enterprise Performance Reporting Cloud Service" 
displayVersion="11.1.2.5.410"> 
<Server name="EPRCS" context="http://abcsvr.xyzco.com.com:9000/epm/SmartView"></Server>
</Product>
<helpurlcontext>http://abcxyzcowebserver:12345/user_documentation/smartview_help/</
helpurlcontext>
<UPK>http://download.abcxyzco.com/ocomdocs/PlayerPackage/data/toc.html</UPK>
</res_GetProvisionedDataSources>
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Installing and Configuring Help

Locally or on a Web Server

In This Chapter
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About Installing Help Locally or on a Web Server
After installing Smart View, the online help is accessed from a URL hosted on the Oracle.com
web site. This is the default behavior for Smart View, and no changes are required by users to
launch help.

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than Oracle.com
are:

l Help files must be installed on a local drive on an individual's computer for Section 508
accessibility purposes.

l Internet access limitations; for example, your users only have access to URLs on your
organization's intranet.

To accommodate the above types of cases, a help zip file can be downloaded from My Oracle
Support. You unzip the help to a local drive or web server, and then modify the Smart View
properties.xml file to point the help location.

Note: Depending on your requirements, you may also want to specify the
<helpurlcontext> tag in a shared connections XML file, as described in “Setting Up
the Shared Connections XML File” on page 31 of Chapter 3, “Accessing Shared
Connections from an XML File”. Refer to “Optional Local Help Configuration via the
Shared Connections XML File” on page 42 for more information.

Setting Up Help Locally or on a Web Server

ä To install and configure Smart View help locally or on a web server:

1 Obtain the help zip file for this release from My Oracle Support.
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2 Extract the contents to either a local folder on the computer where Smart View is installed or to a folder
accessible by your users on an HTTP web server in your organization.

For example:

l Extract the contents locally to:

C:\Oracle\SmartView\

The extraction adds an additional folder named smartview_help. The result is:

C:\Oracle\SmartView\smartview_help

l Extract the contents to a web server:

http://webServerHost:webServerPort/pathToHelpFiles

The extractions adds smartview_help after pathToHelpFiles. The result is:

http://webServerHost:webServerPort/pathToHelpFiles/smartview_help

Under the smartview_help folder, there are 28 language folders; for example:

C:\Oracle\SmartView
               \smartview_help
                    \ar
                    \cs
                    \da
                    \de
                    \el
                    \en
                    \es
                    \fi
                    \fr
                    \fr_CA
                    \he
                    \hu
                    \it
                    \ja
                    \ko
                    \nl
                    \no
                    \pl
                    \pt
                    \pt_BR
                    \ro
                    \ru
                    \sk
                    \sv
                    \th
                    \tr
                    \zh_CN
                    \zh_TW

The following language folders contain translated versions of the Smart View help:

                    \de
                    \es
                    \fr

40



                    \it
                    \ja
                    \ko
                    \nl
                    \pt_BR
                    \zh_CN
                    \zh_TW

The remaining language folders contain the English version of the help. When you run Smart
View in one of those languages (for example, Swedish) and you click a button for Help, the
English help is displayed.

Additionally, the English folder contains a copy of the help in PDF format,
smartview_user.pdf.

3 Modify the helpurlcontext property in the Smart View properties.xml file:

a. In your Smart View installation, navigate to the SmartView\cfg folder.

b. Make a backup copy of the original properties.xml file.

c. Open properties.xml for editing.

d. Modify the helpurlcontext property, providing the path to the folder that is parent
to the language folders using the following syntax:

l If installing locally, provide the path to the folder that is parent to the language
folders using the following syntax:

<helpurlcontext>file:///parent_language_folder_path/</helpurlcontext>

Tip: Use forward slashes in the syntax and ensure that you enter a final forward
slash (/) after the parent language folder path that you provide.

Using the example from step 2, after extracting the zip contents to C:\Oracle
\SmartView, the smartview_help folder is the parent folder of the language
folders. Thus, you would modify the parent_language_folder_path
placeholder as follows:

<helpurlcontext>file:///C:/Oracle/SmartView/smartview_help/</helpurlcontext>

l If installing on a web server, provide the path to the folder that is parent to the
language folders using the following syntax:

<helpurlcontext>http://webServerHost:webServerPort/pathToHelpFiles/
smartview_help/</helpurlcontext>

Tip: Use forward slashes in the syntax and ensure that you enter a final forward
slash (/) after the parent language folder path that you provide.

Using the example from step 2 and substituting user_documentation for
pathToHelpFiles, after extracting the zip contents to http://abcxyzco.com:
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12345/user_documentation, the smartview_help folder is the parent folder
of the language folders. For example:

<helpurlcontext>http://abcxyzco.com:12345/user_documentation/smartview_help/
</helpurlcontext>

4 Restart your Microsoft Office applications and access the help from the Smart View ribbon.

5 Repeat this procedure for each computer that requires Smart View local help.

Optional Local Help Configuration via the Shared
Connections XML File
In a new installation, Smart View help is available as soon as you start Excel. You do not need
to be connected to a Smart View provider in order to view the help. After making the changes
to the properties.xml file described in this chapter, help is accessed from the help location
you indicate.

If you are also planning to access shared connections from an XML file (as described in
“Accessing Shared Connections from an XML File” on page 31), AND you require an alternative
location for the help, note the following:

l You can add the <helpurlcontext> tag to the shared connections XML file. The help
location you specify in the shared connections XML file overrides the help location specified
in properties.xml once you click the Shared Connections button in the Smart View Panel.
This is true whether or not you modify the <helpurlcontext> tag in properties.xml.

l If you do not add or specify the <helpurlcontext> tag to the shared connections XML
file, then the local help defined in the properties.xml file will ALWAYS be used and is
available as soon as you start Excel.

42



5
Tips and Troubleshooting
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Diagnostics Tools
When an issue arises while using Smart View that you cannot resolve on your own, you can use
the Smart View Diagnostic tools in the Diagnostics group in the Smart View ribbon to create
and collect log files and screenshots to send to Oracle Support. When you are finished collecting
diagnostic data, you use the diagnostic tools to zip up the files. Then you transmit the ZIP file
to Oracle Support for analysis. The log files and screenshots are used by Oracle Support to
troubleshoot and resolve your issue.

You can customize certain features of Smart View Diagnostic tools; for example:

l Hide data values in an Office document.

l Hide member names in an Office document.

l Direct the diagnostics output files to a folder other than the default.

l Allow automatic screenshots for each warning or error message that is displayed.

See the “Smart View Diagnostics” chapter of the Oracle Smart View for Office User's Guide for
more information on the Diagnostics tools.
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Installation and Languages
The Smart View installer uses the language set in the Format field of the Windows Region and
Language dialog box, Formats tab. This language also becomes the default language when running
Smart View.

After installation, anytime you change the Smart View language setting (Options dialog box,
Advanced tab), Smart View remembers the new setting on each subsequent launch of Excel.

To return Smart View to the default language, you can use either of the following methods in
the Options dialog box, Advanced tab:

l Click the Reset button.

l Select the first option in the Language drop-down list. This is always Default, which is the
language specified in the Region and Language dialog box, Formats tab

After uninstalling and then reinstalling, Smart View reverts to the language specified in the
Windows Region and Language dialog box, Formats tab, and not the last language specified in
the Smart View Options dialog box, Advanced tab.

Windows, Office, and Smart View Locale Settings
On each Smart View client machine, the following locale settings should match:

l Smart View language option

l Microsoft Office language

l Windows Regional Settings

l Windows operating system

Running Smart View in a language other than the language of the machine's Windows operating
system, system locale, or Office language, may result in incorrect data being returned. For
example, if the Windows operating system, system locale, and Office language are English, and
you run Smart View in Russian, reports or chart data may display incorrectly.

Error When First Launching Excel After Installing Smart
View
After installing Smart View and launching Excel for the first time, you may get an error message
similar to the following: “Unable to set the installed property of the add-in class.”

Workarounds: Enable the Smart View Excel add-in using one of the following methods:

Trust Center Method

1. Perform the task appropriate for your Office version:

l 2013 and 2010: Go to File, then Options, and then Trust Center.
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l 2007: Click the Office button in the top left corner of Excel, then select Excel Options,
and then Trust Center.

2. Click the Trust Center Settings button.

3. In the left pane, select Trusted Locations.

4. Click Add new location to launch the Microsoft Office Trusted Location dialog box.

5. In Path, enter:

C:\Oracle

6. Click OK.

7. Click OK to close the Trust Center, and then click OK to close Excel Options.

COM Add-ins Method:

1. Perform the task appropriate for your Office version:

l 2013 and 2010: Go to File, then Options, and then Add-ins.

l 2007: Click the Office button in the top left corner of Excel, then select Excel Options,
and then Add-ins.

2. From Manage, select COM Add-ins, and then Go.

3. In COM Add-ins, select the check box to enable the Oracle Smart View for Office add-in, and
click OK.

Internet Explorer Compatibility View Settings for
Financial Reporting
When running a Financial Reporting report from Smart View, a web control is called that causes
this error to display: “The product does not support compatibility view. Contact your system
administrator to help configure your settings.”

By default, the web control runs in compatibility mode, triggering the compatibility message.

Workarounds:

l Click to clear the message, and the report preview displays as expected.

l To avoid the compatibility message, modify the Windows Registry as follows.

For 32-bit Office:

In [HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Internet
Explorer\MAIN\FeatureControl\FEATURE_BROWSER_EMULATION], add the
following three DWORD (32-bit) values:

"EXCEL.EXE"=dword:00008000
"POWERPNT.EXE"=dword:00008000
"WINWORD.EXE"=dword:00008000

For 64-bit Office:

45



Add the three DWORD values for Excel, PowerPoint, and Word in [HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Internet Explorer\MAIN\FeatureControl

\FEATURE_BROWSER_EMULATION].

The values must match your installed version of Internet Explorer. If you are unsure which
entry to use, then use the 32-bit Office values noted above.

Internet Explorer 8:

"EXCEL.EXE"=dword:00008000
"POWERPNT.EXE"=dword:00008000
"WINWORD.EXE"=dword:00008000

Internet Explorer 9:

"EXCEL.EXE"=dword:00009000
"POWERPNT.EXE"=dword:00009000
"WINWORD.EXE"=dword:00009000

Internet Explorer 10:

"EXCEL.EXE"=dword:00010000
"POWERPNT.EXE"=dword:00010000
"WINWORD.EXE"=dword:00010000

Internet Explorer 11:

"EXCEL.EXE"=dword:00011000
"POWERPNT.EXE"=dword:00011000
"WINWORD.EXE"=dword:00011000

Working with Custom HTML-based Login Forms
If you are using a custom HTML-based login form instead of the default Oracle Access Manager
login form, ensure that the source of the custom form includes the string loginform. This is
required for Smart View integration with Oracle Access Manager to work.

Browser Settings When Working with XML Files on HTTP
Server
Internet Explorer may cache XML files posted on an HTTP server and referenced by Smart View.
This can cause problems when using the following Smart View functionality:

l Accessing shared connections from an XML file

This is the XML file posted on an HTTP server and noted in the Shared Connections URL
field of the Smart View Options dialog box. If you plan to access online help from a local
drive or internal web server, this file can also specify the location of the help.

l Updating extensions
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Smart View references the UpdateList.xml file that is posted on an HTTP server when
Smart View end users install, update, and remove extensions in the Extensions tab of the
Options dialog box.

Complete the steps in this topic to clear the browser cache so that the latest version of the XML
file is used for the purposes noted above.

ä To clear the cache so that Smart View is accessing the latest XML file version posted on an
HTTP server, set the following options in Internet Explorer:

1 Select Tools, then Internet Options.

2 In the General tab, Browsing history group, select Settings.

3 In the Check for newer versions of stored pages section, select Every time I visit the webpage, and
then click OK.

4 In the Internet Options dialog box, select the Advanced tab.

5 In the Security section, select the Empty Temporary Internet Files folder when browser is closed option.

6 Click OK to close Internet Options and restart the browser.

Flickering Issues on Office 2013 32-bit and 64-bit
When using Smart View with Microsoft Office 2013, flickering occurs with the POV toolbar and
the Smart View Panel. The flickering is likely caused by changes in Excel 2013.

To reduce flickering, Oracle advises that you take the following actions:

l Ensure that you have installed one of the following Microsoft updates:

m KB2863880 (hotfix): http://support.microsoft.com/en-us/kb/2863880

m KB2825631 (public): http://support.microsoft.com/en-sg/kb/2825631

To check if an update is already installed on your machine, go to Control Panel, then
Programs and Features, and then “View installed updates.” In the Search box, enter the KB
number for each update; for example, enter KB2863880, and then enter KB282563. If one
of the updates is installed, then you do not need to install any other update. If no results are
returned for either, then you must install one of the updates.

l Add two registry keys (described in the sections below).

m “Disable Window Transitions (DisableWindowTransitionsOnAddinTaskPanes)” on
page 48

m “Disable Office Animations (DisableAnimations)” on page 48

47

http://support.microsoft.com/en-us/kb/2863880
http://support.microsoft.com/en-sg/kb/2825631


Disable Window Transitions
(DisableWindowTransitionsOnAddinTaskPanes)
To improve the user experience, you may enable
DisableWindowTransitionsOnAddinTaskPanes for 2013 by adding this key value to the
Toolbars key in the Windows Registry. To do this, add the
DisableWindowTransitionsOnAddinTaskPanes key value to the Toolbars key as follows:

l Key Name:

[HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\Toolbars]

l Key Value:

"DisableWindowTransitionsOnAddinTaskPanes"=dword:1

ä To add DisableWindowTransitionsOnAddinTaskPanes to the Toolbars registry key:

1 Click Start, click Run, type regedit in the Open box, and then click OK.

2 Locate and then select the following registry subkey:

HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\Toolbars

3 From the Edit menu, select New, and then select DWORD Value.

4 Type DisableWindowTransitionsOnAddinTaskPanes, and then press Enter.

5 In the Details pane, right-click DisableWindowTransitionsOnAddinTaskPanes, and then select
Modify.

6 In the Value data box, type 1, and then click OK.

7 Exit Registry Editor.

8 Restart Excel 2013.

Disable Office Animations (DisableAnimations)
To further improve the user experience, you may disable Office Animations for 2013 by adding
a key and key value to the Windows Registry. To do this, create the Graphics key and Disable
Animations key value as follows:

l Key Name:

[HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\Graphics]

l Key Value:

"DisableAnimations"=dword:00000001

ä To create and update the registry key, Graphics:

1 Click Start, click Run, type regedit in the Open box, and then click OK.

2 Locate and then select the following registry subkey:

HKEY_CURRENT_USER\Office\15.0\Common\

3 From the Edit menu, select New, and then select Key.
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4 Type Graphics, and then press Enter.

5 From the Edit menu, select New, and then select DWORD Value.

6 Type DisableAnimations, and then press Enter.

7 In the Details pane, right-click DisableAnimations, and then click Modify.

8 In the Value data box, type 00000001, and then click OK.

9 Exit Registry Editor.

10 Restart Excel 2013.

Issues When Starting Excel in Automation Mode

Problem

In some cases, third-party software that automates Excel processes, such as exporting to Excel,
may cause issues with Excel and a conflict with Smart View.

Solution

To disable Smart View when Excel is started in automation mode, you may enable
“DisableInAutomation” by adding a key and key value to the Windows Registry. To do this,
create the Options key and DisableInAutomation key value as follows:

l Key Name:

[HKEY_CURRENT_USER\Software\Oracle\SmartView\Options]

l Key Value:

"DisableInAutomation"=dword:00000001

When set to 00000001, Smart View is disabled when Excel is started in automation mode.
Smart View starts correctly when Excel is started manually, outside of an automated process.

When set to 0 or not created at all, then Smart View is enabled and starts when Excel is
started in automation mode, which may cause issues. Smart View starts correctly when Excel
is started manually, outside of an automated process.

Creating the Registry Key and Key Value

To create and update the registry key, Options:

1. Click Start, click Run, type regeditin the Open box, and then click OK.

2. Locate and then select the following registry subkey:

HKEY_CURRENT_USER\Software\Oracle\SmartView\

3. From the Edit menu, select New, and then select Key.

4. Type Options, and then press Enter.

5. From the Edit menu, select New, and then select DWORD Value.

6. Type DisableInAutomation, and then press Enter.
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7. In the Details pane, right-click DisableInAutomation, and then click Modify.

8. In the Value data box, type 00000001, and then click OK.

The value, 00000001, enables the DisableInAutomation key.

Note: If a zero value is entered, then this option is disabled.

9. Exit Registry Editor.

10. Restart Excel.

Slowness with Extension Options Dialog Box
When opening the Extensions tab of the Options dialog box or when checking for extension
updates, if your system seems to be taking a long time to complete these tasks, ensure that the
machine has access to the internet.

Performance and Memory Usage Considerations for
Smart View with Excel
Smart View is a Microsoft Office add-in. As an add-in, it is loaded in to the Microsoft Excel
process. When a report is imported in to Excel through Smart View, the Excel process consumes
memory and this can negatively impact performance.

For example, instances of grids and forms, objects in the Undo buffer, XML parsing, etc., will
cause the Excel process to consume memory. Because of this, the Excel or machine memory
limit becomes the Smart View memory limit as well. This can severely impact performance.

There is no memory configuration parameter in Smart View to manage this.

Excel 32-bit and 64-bit have different memory limits.

l For Excel 32-bit, the maximum memory limit, or RAM, is 2GB.

Oracle testing showed that when Excel 32-bit memory usage reaches beyond 700 MB, Excel
can behave abnormally and can terminate unexpectedly.

l The 64-bit versions of Excel are not constrained to 2 GB of RAM, as are the 32-bit Office
applications.

For large reports, Oracle recommends using 64-bit Excel. Or consider reducing the data
being sent to Smart View by reducing the number of rows, columns, and POVs in the reports.

Oracle suggests that you consider taking some or all of the actions listed below in an effort to
limit memory usage and improve performance.

The following actions can help to limit memory usage:

1. Ensure that these options are enabled in the Smart View Options dialog box, Advanced tab:

l Reduce Excel File Size
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l Improve Metadata Options

2. In the Options dialog box, Advanced tab, set Number of Undo Actions to '0' (Zero), if possible,
or to a low number such as 1 or 2.

3. Change Excel calculation from Automatic to Manual. Go to the Excel Formulas ribbon, then
select Calculation Options, and then select Manual.

4. In the Options dialog box, Formatting tab, if you have selected the Use Excel Formatting option,
then you should clear the Move Formatting on Operations option.

5. In the Options dialog box, Formatting tab, clear the Adjust Column Width option.

6. In the Options dialog box, Extensions tab, disable any unneeded extensions.

7. In Excel, to improve performance and stability, disable or uninstall any unused add-ins. For
example, disable or uninstall the Oracle Essbase Spreadsheet Add-in. Other possible add-
ins to disable or uninstall are, for example, Adobe PDF, WebEx, or Send to Bluetooth

8. Reduce the workbook size.

9. Limit the data imported to Excel:

a. Use prompts, filters, POVs, or other ways to reduce the data returned back to Smart
View.

b. Enable the Suppress Rows and Suppress Columns options in the Data Options tab of the
Smart View Options dialog box.

The following actions can help to improve performance, as well as limit memory usage:

1. In the Options dialog box, Advanced tab, set Number of Undo Actions to '0' (zero), if possible.

2. In the Options dialog box, Member Options tab, ensure that these options are cleared:

l Preserve Formulas and Comments in ad hoc options

l Formula Fill

Clear these options only if you do not need to preserve formulas or comments during ad
hoc operations.

Also, refer to the following documentation from Microsoft, “Excel 2010 Performance:
Performance and Limit Improvements”:

http://msdn.microsoft.com/en-us/library/ff700514(v=office.14).aspx

Smart View HTTP Session Timeout
HTTP session timeouts can occur, for example, when working with large queries that take a long
time to run, or when you're experiencing slower internet connections.

To avoid HTTP session timeouts, you may add the following Windows Registry DWORDS to
the Internet Settings key:

l Key Name:
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HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings

l Key Values:

m DWORD: ReceiveTimeout

Value data: value in milliseconds

m DWORD: KeepAliveTimeout

Value data: value in milliseconds

m DWORD: ServerInfoTimeout

Value data: value in milliseconds

For example, 900000 milliseconds is the equivalent of 15 minutes. Adjust the timing
according to your requirements.

As a guideline, 900000 milliseconds is the equivalent of 15 minutes.

ä To add the timeout key values to the Internet Settings registry key:

1 Ensure that all Office applications, including Outlook, are closed.

2 Launch the Windows Registry Editor.

3 Locate and then select the following registry subkey:

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings

4 Add the three DWORD key values, ReceiveTimeout, KeepAliveTimeout, and
ServerInfoTimeout:

a. From the Edit menu, select New, and then select DWORD Value.

b. Type the DWORD name, and then press Enter.

c. In the Details pane, right-click DWORD you added in step 4.b, and then select Modify.

d. In the Value data text box, type the timeout value in milliseconds, select Decimal, and
then click OK.

e. Repeat step 4.a through step 4.d for each of the three required DWORD key values.

5 Exit Registry Editor.

6 Restart Excel.

Duplicate Queries in Word Slow to Refresh
In some Word documents containing a large number of queries and created prior to Smart View
release 11.1.2.5.520, performance may be an issue when refreshing the data in the document. In
some cases, instead of re-using existing queries where appropriate, each Smart View data point
in the Word document is treated as a separate query. The result is that Refresh operations can
be very slow.
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If the document contains many duplicate queries (that is, queries with the same name), the
duplicate queries are displayed in the Document Contents pane in Word. For example,
Document Contents might look like this:

The duplicate queries are SmartView14446361770 and SmartView14446541490.

You can run Visual Basic macro below to remove the duplicate queries:
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Sub DeleteExtraQueries() 
 ' 
 ' DeleteExtraQueries Macro 
 ' 
 Dim queriesName As Variant 
 Dim uniqueQueriesName As New Collection 
 Dim varName, newList As String 
 Set vars = ActiveDocument.Variables 
 
  For i = 1 To vars.Count 
     varName = vars.Item(i).Name 
     If Not StrComp(vars.Item(i).Name, "SV_QUERY_LIST", vbTextCompare) Then 
         List = vars.Item(i).Value 
         queriesName = Split(List, "<|>") 
         
         On Error Resume Next 
         For Each queryName In queriesName 
             uniqueQueriesName.Add queryName, queryName 
         Next 
         newList = "" 
         For Each queryName In uniqueQueriesName 
             newList = newList & queryName & "<|>" 
         Next 
         newList = Left(newList, Len(newList) - 3) 
         vars.Item(i).Value = newList 
     End If 
     
 Next 
 
End Sub

After running the macro, the two queries, SmartView14446361770 and
SmartView14446541490, appear only once in Document Contents:

Issues with Dynamic Data Exchange Option in Excel
Various issues may arise when the Excel option, Ignore other applications that use Dynamic Data
Exchange (DDE), is selected. For example, there are problems launching Excel, launching Excel
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files from outside of Excel, and using the Export in Query Ready Mode option from a browser to
export balances from Financial Reporting.

Workaround: Click the Microsoft Office Button (upper left corner of Excel), and then click
Excel Options. In the Advanced category, scroll down to the General options, and then clear the
Ignore other applications that use Dynamic Data Exchance (DDE) check box. Restart Excel.

Transition Navigation Keys Not Supported
Smart View does not support Excel’s Transition navigation keys option.

Due to a Microsoft limitation, many of the Microsoft APIs that Smart View depends on for both
Smart View and Excel functionality do not work when the Transition navigation keys option is
enabled. For example:

l In Excel, copy/paste, macros, automation API calls do not work correctly.

l In the Planning Admin extension, member formula formatting in the Smart View
Dimension Editor does not display correctly; formulas have incorrect syntax when
submitted to Planning.

In order to ensure the best performance possible, Smart View requires the following:

l The Excel option, Transition navigation keys, must be cleared.

l The Smart View option, Improve Metadata Storage, must be enabled (by default, this option
is enabled).
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This appendix describes limitations you may encounter while working with Smart View.

General
l In PowerPoint, you may not be able to access Smart View functions through Microsoft smart

tags.

Workaround: Retype “smartview” (the Smart View smart tag) to cause PowerPoint to reload
the smart tag.

l When you open a saved free-form workbook and change the Member Name Only or
Member Name and Description setting in the Options dialog box before refreshing, the
member display options do not work.

Workaround: Refresh the grid before entering Member Name Only or Member Name and
Description.

l Because of a Microsoft Word limitation, if the value of the system-defined option "List
separator" is set to one of the regular expression anchor characters (including but not limited
to "^" and "$"), Word might fail to insert fields of type "Formula," which will cause failure
of copy and paste.

Workaround: Go to Control Panel, then Regional and Language, then Options, then
Standards and Formats, then Customize, and then Numbers, and change the list separator
option.

l Do not change the file extension when you save an Excel workbook with the Get function
that has been retrieved through simulation workbooks in the Smart View Panel.

l Sheet names may be truncated if they are longer than 31 characters; this is an Excel limitation.
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l To use Outlook with Smart View, Visual Basic Scripting Support must be installed and Run
From My Computer must be selected in Outlook. See Outlook product documentation for
information.

l In Microsoft Word, slider controls may be resized in reports created in the Report Designer.

l When you perform drill-through from an Oracle Essbase Studio-sourced cube to FDM, if
the EPM System Single Sign-On (SSO) token expires before the sessions of all products
involved expires (Workspace, Provider Services, Essbase, Essbase Studio, FDM), the
following message is displayed: “Error: An error occurred logging on to the system using
single sign-on. Please contact your administrator. Error: 2067 -- You do not have access to
the application!”

Workaround: Log in again to EPM Workspace from Smart View.

l When you delete a worksheet containing a reporting object from the Report Designer, Excel
may terminate abruptly. This is a Microsoft issue.

l Sliders in Smart Slice reports do not display properly after the report is closed and reopened.
This happens because of a Microsoft security setting for ActiveX controls and OLE objects
in Office 2007. See the Microsoft support site for information about working around this
issue.

l If you use Microsoft COM or Automation Add-ins to open Excel, the Smart View ribbon
or menu is not displayed, and you cannot automate Smart View. This happens because Smart
View cannot be loaded through automation.

Workaround: Open Excel from EXCEL.EXE located in the Office installation folder,
typically C:\Program Files\Microsoft Office\Office12. This workaround is
effective only if you do not need to do any further automation. For more information and
a complete workaround, see Knowledge Base Document 1453237.1, “SmartView
Functionality Changed: Cannot Automate SmartView from Another Program, ” available
from My Oracle Support.

l In Smart Query, no results may be returned when you use an equals sign (=) in a filter
definition based on value. This happens if the decimal places displayed for numbers in Excel
in Smart View is different from that set in Essbase for the connection.

Workaround: Use the same “decimal places displayed for numbers” setting in both Excel
and Essbase.

l When working with larger workbooks, or performing an operation that results in a large
data set, a “not enough resources” error may occur.

Workarounds:

m Break up your workbook into smaller workbooks.

m Upgrading to Office 64-bit may resolve the issue.

l When inserting a Smart Slice into a report and refreshing the sheet, the report table is not
refreshed and the table data is not visible.

Workaround: If the data is not visible, click on the first few empty cells; data will then start
displaying.

l Zooming out after performing a zoom in can leave blank rows on the worksheet.
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Workaround: This is not a specific Smart View issue but may be related to excess formatting
not being removed by Excel. Oracle recommends trying the following Microsoft
workarounds:

m Reset the last cell in Excel

m Download and use the Microsoft Excel Excess Formatting Cleaner Add-in

Essbase
l In the Query Designer, Smart View generates a syntax error when you perform a descendants

or top/bottom query on a member whose name contains a dot (.).

l Calculation scripts that run from Essbase may not run from Smart View. This can happen
if you have restricted calculation access in Smart View. Calculation scripts are run against
the connected database.

l When you perform an Undo, only the previously selected POV is saved, and recently selected
members are removed.

Workaround: instead of using Undo, use Pivot to POV, which will replace all members on
that dimension to the POV.

l When you perform Smart View operations in a Smart Slice and refresh, you may get an
Assertion Failed error message if you try to close Excel by clicking the X in the upper right
corner. The message is harmless; you can click OK to close it.

l Using Find in the Member Select dialog box may cause Excel to perform excessively slowly
or freeze if the dimension contains more than approximately 100,000 members.

l If you use merged cells, you may encounter the following issues:

m When there are merged cells in a row dimension, proper merging is not maintained
when you zoom in on the top cell of the innermost row dimension.

m When you use the Formula/Format Fill option with merged cells in a row dimension,
Formula/Format Fill does not fill cells properly when you zoom in on the innermost row
dimension.

The POV must contain more than one dimension. If there is only one dimension on the
POV, it will be pivoted to the grid when you refresh.

l The Function Builder cannot distinguish among substitution variables with the same name.

l Numerical values entered into cells that are outside the grid may be lost upon refreshing

l If you add members in a column left of a column of blank cells, the new members may be
lost after you refresh. This happens because the blank cells are not valid intersections.

l If you are connected to an earlier version of Essbase, custom members that you create using
Smart Query may not be applied when you switch from a Smart Query worksheet to ad hoc
analysis.

l Member names that contain a hash mark (#) may cause errors.

Workaround: Do not use hash marks in member names.
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l Smart View does not support dual- monitor operation. For example, in Microsoft Word
and PowerPoint, the POV control in Smart Slices may not display properly when you are
connected to more than one monitor.

Planning
l If you have cascaded a report created from a new Smart Slice containing at least one function

grid and a control (slider or POV) across an Excel workbook, Excel may terminate abruptly
if you choose not to save the cascaded report.

l Smart View does not permit the use of #Missing in Calc Manager rules, even if the variable
is set to permit #Missing.

l In data forms previously saved in an Excel workbook, expanding a member may result in
data that is incorrectly displayed as zero or No Access.

Workaround: To display the correct data, refresh the worksheet or submit data.

l Tasks imported into Outlook via Smart View can cause errors if Outlook is configured for
Oracle Beehive.

Workaround: In Outlook Send/Receive settings, select None for the Task List folder. See
the Outlook documentation for information.

l Read-only Dynamic Calc cells may be displayed incorrectly as writable in offline data forms
with the suppress missing option set to true.

l The Offline wizard continues to be displayed in English when you change to a different
language in Smart View.

l Planning servers added via “Add new server” from the Smart View Panel are not displayed
in the Smart View Panel in Outlook.

l If Suppress Rows is enabled in the Planning data form, new rows of data created in offline
mode by means of a business rule are not saved when you synchronize back to the server.

l If the option Keep data changes made in offline mode is unselected, then any changes made
in an offline data form should be overwritten with data from the Planning web when you
refresh. However, if the suppress missing rows option is selected for the data from, these
changes are retained when you refresh.

l In the Outlook 2007 shortcut menu for tasks, the Assign Task and Mark Complete items
may work only intermittently.

l Closing the Smart View Panel in Outlook may take a long time after you open a task from
a large task list. The reason is that task lists are always refreshed upon closing, and the time
needed to refresh depends, in part, on the number of tasks in the task list.

l Starting with Release 11.1.2.1, Smart View cannot be connected to Planning through
Provider Services. You can connect to Oracle Hyperion Planning directly.
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Financial Management
l Chart data is not properly updated upon Refresh if the data for the current intersection is

#Invalid.

Workaround: Change the slider or POV to a valid data point that displays different data,
and then perform a Refresh. The chart is properly updated.

l POV controls inserted into a report may be disabled when you close and reopen the
document containing the report. This happens when ActiveX controls are disabled.

Workaround: Enable ActiveX controls in Microsoft Office.

l A connection timeout occurs when performing a refresh in the latest version of Smart View
when connected to the 11.1.2 version of Financial Management. This issue is addressed
starting with Financial Management 11.1.2.2.

l Problems with the column suppression options are causing Financial Management grids to
open with a “grid is not well formed” error.

l When performing ad hoc analysis while connected to a Oracle Hyperion Financial
Management data source, with the Suppress Columns options “No Data/Missing” and
“Zero” selected, after clicking Refresh, the corresponding columns are not suppressed and
still appear in the sheet.

Reporting and Analysis
l Filters are not updated in POV toolbar after you edit them; however, data is changed

successfully.

l If you have an open Excel document when you export a Oracle Hyperion Financial Reporting
report in query-ready mode to Excel, the open Excel document will be overwritten without
warning.

Workaround: Save and close any Excel documents before exporting.

l Oracle Hyperion Web Analysis reports imported from EPM Workspace to PowerPoint 2010
do not open correctly.

Workaround: Save the report file as an HTML file. Then open directly in PowerPoint; do
not try to import from Oracle Hyperion Enterprise Performance Management Workspace.
This issue does not apply to versions of PowerPoint other than 2010.

l When you export an Oracle Hyperion Interactive Reporting report from Internet Explorer
into Smart View 11.1.2.1.x, the Smart View ribbon disappears in Excel.

Workaround: Open Excel before exporting from Internet Explorer.

l Autodeployment does not work for Oracle Hyperion Reporting and Analysis release 11.1.1.4
or earlier.
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FDM
Oracle Hyperion Financial Data Quality Management does not support alias tables for Oracle
Essbase drill-through.

Enterprise Performance Reporting
l Member names that contain a hash mark (#) may cause errors.

Workaround: Do not use hash marks in member names.

l Oracle Enterprise Performance Reporting Cloud does not support the following Oracle
Smart View for Office functionality:

m Formula preservation and formula fill

m Cell Styles

m Smart Query

m Submit Data

m Cascading

m Display Member Name and Alias

m Member Information

m Smart Slices
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